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Para iniciar, ndo é necessario que vocé seja 0 génio das artes, afinal nas
tltimas versdes do Photoshop muitas ferramentas e efeitos estdo sendo
realizados quase que automaticos, assim facilitando a vida do iniciante.

Algumas anotac¢des importantes:
Menu Principal

Barra de Propriedades

Caixa de Ferramentas

Painéis

Area de Trabalho

Area do Documento

Vamos abrir a nossa imagem e tentar dar-lhe uns tons ndo muito fortes para o
resultado ser o mais natural possivel.

Neste caso a primeira coisa que fiz foi ajustar as curvas da foto (CTRL+M) para
a tornar ligeiramente mais clara principalmente na zona do rosto que é o que
queremos destacar.

Agora vem a parte da "mudanca” que, ao contrario do que poderiam pensar,
nao € tdo complicado assim. Vamos alterar a cor do cabelo/sobrancelhas,
macas do rosto, labios e salientar mais a cor dos olhos. Para cada um destes
pontos vamos fazer o seguinte:

Cabelo/Sobrancelhas, labios e olhos:

1° SHIFT+CTRL+N para cada um dos detalhes (ou seja 3 layers vazias neste
caso) onde vamos pintar o cabelo/sobrancelhas (mesma layer), labios
(seleccionar outralayervazia e pintar) e olhos (seleccionar a
terceira layer vazia e colorir);

2° Alterar a blending option (b.0.) da layer de Normal para Overlay;



3° Escolher a cor para pintar o] respectivo detalhe
(caso ndo gostem da cor e ja tenham pintado, ndo se preocupem... podem
apagar com a borracha e voltar a pintar com outra cor);

4° Ajustar a opacidade (opacity) consoante a quantidade de cor que queremos
(+ claro/+ escuro) e ir vendo como fica na foto.

Magcas do rosto:

1° SHIFT+CTRL+N para este detalhe também (ou seja 1 layer vazias);

2° Alterar a blending option (b.0.) da layer de Normal para Color;

3° Escolher a cor para maquilhar (normalmente rosa ou vermelho escuro);

4° Ajustar a opacidade (opacity) consoante a quantidade de cor que queremos
(+ claro/+ escuro) e ir de novo vendo como fica na foto.

Em todos estes passos ndo se preocupem se pintarem fora das zonas. Usem a
borracha com uma dureza (hardness) de cerca de 10/20% e apaguem nos
sitios que ndo devem ter cor para que o trabalho fique perfeitinho. E também
nao esquecam de usar a borracha no sitio dos dentes para que estes nao
figuem  coloridos. Depois  podemos unir tudo  fazendo merge
down (SHIFT+CTRL+E).

Como os olhos sdo um dos elementos faciais que mais se destacam nas fotos,
vamos dar especial atencdo a eles. Neste caso, apliqguei umas pestanas falsas
e escureci o0 sobrolho para que o retrato parecesse mais maquilhado. Tenham
0 cuidado de guardar o arquivo neste caminho (ou semelhante) do vosso
computador "C:\Program Files\Adobe\Adobe Photoshop CS4\Presets\Brushes".
Para ndo perderem o trabalho basta fazerem Ficheiro/Abrir... (File/Open...) e
vao a pasta acima onde vao seleccionar o brush (deve estar com este nome
"eyelashes by trisste_deviantart_com”) e clicam em abrir.

1: A semelhanca do que fizemos para maquilhar o cabelo e afins, também aqui
vamos criar uma layer vazia para cada pestana. A seguir seleccionamos



a brush tool e onde habitualmente estd um circulo, (na barra das
definicbes da ferramenta) vamos percorrer o menu e seleccionar o
nosso brush. Temos de ter cuidado para ajustar o tamanho do brush(master
diameter) para o tamanho do olho (ver imagem ao lado).

2: Carimbar a pestana por cima do olho esquerdo (com a layer "pestana

esquerda" seleccionada). Atencdo que é necessario a foregound color

ser o preto. Depois de carimbar uma pestana, fiz CTRL+T para a seleccionar
na totalidade e com o bot&o do lado direito cliquei e seleccionei a opgao warp
tool. Esta parte exige alguns conhecimentos de como manusearuma
imagem. O brush vai ficar com uma espécie de grelha onde podemos mexer,
puchar, encolher... etc. Basta experimentarem que logo percebem como
funciona.

3: Fiz o mesmo procedimento para a pestana direita (com a layer pestana
direita seleccionada) e com a borracha dei uns toques e apaguei zonas que
nao queria que o brush preenchesse.

4: A seguir para dar um toque mais real, seleccionei a burn tool com 0S
valores abaixo e retoquei nas zonas mais escuras para ndo se notar a
diferenca do olho para o sitio onde a pestana foi colocada e ficar tudo mais
uniforme. Dei também um toque no sobrolho para parece mais maquilhado.

Com a dodge tool *. seleccionada e com os valores abaixo, ponteei o brilho
do olho para o salientar mais um pouco. A seguir tem de se unir tudo de novo
(SHIFT+CTRL+E).

Vamos agora alisar ligeiramente a pele. Para isso duplicamos a layer (CTRL+J)

e vamos usar a blur tool para passar na pele do rosto e do ombro (que € o
gue esta focado na fotografia). Nao se preocupem se ficar demasiado alisado
ou pastel. A seguir podem ajustar a opacidade ao vosso gosto (como na
imagem abaixo) e ficar com a tez mais natural.

E aqui esta a nossa imagem final. Apenas adicionei um ligeiro detalhe que foi
pintar com um tom suave (cinza neste caso) a volta da modelo para a foto ndo
ficar tdo branca.
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Adobe Photoshop é um software caracterizado como editor de
imagens bidimensionais do tipo raster(possuindo ainda algumas capacidades
de edicfo tipicas dos editores vectoriais) desenvolvido pela Adobe Systems. E
considerado o lider no mercado dos editores de imagem profissionais, assim
como o programa de facto para edicdo profissional de imagens digitais e
trabalhos de pré-impresséo.

Sua mais recente versao é apelidada como Adobe Photoshop CC (sigla cujo
significado é Creative Cloud, correspondente a sua décima quarta edicao [14.0]
desde seu lancamento), disponivel para os sistemas operativos Microsoft
Windows e Mac OS X. Pode ser rodado também no Linux, através da camada
de compatibilidade Wine. Algumas versfes anteriores foram lancadas também
para IRIX, mas o suporte a esta verséo foi descontinuado apos a verséao 3.0.

O software Photoshop foi concebido em 1987, por Thomas Knoll, na Califérnia,
Estados Unidos. Knoll estava em casa trabalhando em sua tese de doutorado,
guando criou um cédigo em seu computador que exibia imagens em tons de
cinza em um monitor de bitmap preto e branco. Como o cédigo ndo estava
diretamente relacionado a sua tese de doutorado, Knoll subestimou o seu valor.
Mal sabia ele que esse era o primeiro esboc¢o do fenémeno Photoshop.

SO mais tarde, quando seu irmdo John Knoll, que na época ja trabalhava na
ILM (Industrial Light & Magic), se encantou pelo programa, que ele percebeu
seu potencial. Ambos trabalharam juntos para desenvolvé-lo e em 1990 o viram
lancado pela Adobe, que havia comprado o programa.

Os irméos Thomas Knoll e John Knoll iniciaram o desenvolvimento do
Photoshop em 1987 e a versdo 1.0 foi lancada pela Adobe em 1990. O
programa era destinado desde o inicio como ferramenta de manipulacdo de
imagens provenientes de digitalizadores, que eram raros e dispendiosos
naguela época.

Apesar de ter sido concebido para edicdo de imagens para impressdo em
papel, o Photoshop esta a ser cada vez mais usado também para produzir
imagens destinadas a World Wide Web. Até a versdo 9.0 (CS2) o programa,
o Adobe ImageReady, muito semelhante ao Photoshop, que era utilizado em
conjunto para a edicdo e criacdo de imagens e animacfes para a internet. A
partir da versédo 10 (CS3), os recursos do Adobe ImageReady estdo incluidos
dentro do proprio Photoshop.

O Photoshop também suporta edicdo com outros tipos de programas da
Adobe, especializados em determinadas éareas: o ja referido Adobe
ImageReady (edicdo de imagens para a web), Adobe InDesign (edicdo de
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texto) Adobe lllustrator (edicdo de gréficos vectoriais), Adobe Premiere (edicao
de video nédo-linear), Adobe After Effects (edicdo de efeitos especiais em video)
e 0 Adobe Encore DVD (edicao destinada a DVDs). Os formatos de arquivos
nativos do Photoshop (PSD ou PDD) podem ser usados entre estes
programas.

A titulo de exemplo, o Photoshop CS permite fazer elementos da interface
gréfica de DVDs (menus e botdes), desde que dispostos separadamente no
ficheiro original (PSD ou PDD) por camadas (layers) agrupadas por ordem
especifica, de forma que, ao ser importado pelo Adobe Encore DVD, este
consiga criar a edicdo para DVD com esses elementos.

O uso das camadas ndo € um recurso novo inventado pelos desenvolvedores
do Photoshop, ele foi desenvolvido hd muito tempo pelos ilustradores. Segundo
Richard Valliere em seu livro, Manipulator of Movement: "[...Jem dezembro de
1914 é patenteada aquela que efectivamente foi a maior contribuicdo técnica
para a animacao tradicional até o advento da computacdo grafica: o desenho
sobre folhas de celuldide transparente — em portugués vulgarmente chamada
de acetato". Essa inovacao coube ao animador norte-americano Earl Hurd.”

Portanto, € mais um recurso existente no mundo real que foi aproveitado pela
ferramenta Photoshop para facilitar o trabalho de seus usuarios, assim como
certos efeitos que reproduzem técnicas de pintura, mascaras, uma técnica
muito utilizada em graficas e impressao offset.

Os formatos de arquivos nativos podem ser importados de programas da
concorréncia, como o Corel Photo-Paint, Pixel32, Winlmages, GIMP, Corel
Paint Shop Pro, etc.

O Photoshop suporta varios espacos de cor (color spaces):
SRGB (ponto branco=D65) - RGB no Photoshop

Lab (ponto branco=D50)

CMYK

Escala de cinza (Grayscale)

Em 2002, a Adobe incluiu o Adobe Camera RAW, um plugin desenvolvido por
Thomas Knoll que permite ler varios formatos de ficheiros RAW, provenientes
principalmente de maquinas fotograficas profissionais. Uma versao preliminar
deste plugin esteve opcionalmente disponivel para o Photoshop 7.0.1 a $99
dolares americanos.
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Em 2012 foi langcda a versdo 13.0, também chamada de "Photoshop CS6",
uma vez que "CS" indica a sua integracdo no pacote de programas Adobe
Creative Suite. Quanto ao numero "6" € por ser a sexta versao desde que a
Adobe reformulou a imagem de marca dos seus programas sob a "marca-mae"

(no inglés umbrella brand) "Creative Suite".

Numa tentativa de se separar da imagem de marca anterior do Photoshop,
entre as versdes 3 e 7, em que apresentava o olho humano (num conceito de
visdo e imagem), nas duas primeiras versdes do "Creative Suite" utiliza
imagens de penas estilizadas (como referéncia a escrita e pintura com penas
de aves), mais recentemente, jA na terceira edicdo do "CS", a imagem foi
alterada para um quadrado com as letras "PS" ao centro.

Enquanto o Photoshop é praticamente utilizado por profissionais, o seu preco
elevado deixa margem para outros programas concorrentes ganharem
mercado em outras faixas de mercado, como por exemplo, o GIMP, que é um
programa gratuito, ou Pixelmator, que é um editor semelhante para a
plataforma Macintosh. De forma a competir com este mercado, e também para
combater a pirataria de que o Photoshop é alvo, a Adobe langou um programa
semelhante para o mercado domeéstico, o Adobe Photoshop Elements, mas
com muitas fungdes profissionais removidas do Photoshop original. Enquanto o
Adobe Photoshop CS3 é vendido por sensivelmente 800 euros (verséo
inglesa), o Adobe Photoshop Elements 4.0 custa apenas 130 euros, de forma a
ganhar terreno no mercado domeéstico. Sendo mesmo, por vezes incluido
em digitalizadores de diversas marcas. Como é 6bvio, esta versdo "reduzida”
nao se adequa ao mercado de pré-impressao profissional, visto uma das
principais caracteristicas removidas deste software seja o0 modo de
cores CMYK.

O Photoshop ndo suporta nativamente muitos dos algoritmos de
imagem (Image Arithmetics) que o Corel Paint Shop Pro e outros editores de
bitmaps utilizam. No entanto, esse problema pode ser contornado através
do Filter Factory, um plugin gratuito disponivel nos discos de instalacdo do
Photoshop, apos a verséao 3.0.

@] termo photoshopping (também "photoshopar” no Brasil) e
um neologismo que significa "editar uma imagem" independentemente do
programa que se utilize (de forma similar ao neologismo Googlar). A Adobe
desencoraja o uso do termo devido ao receio de distorcer a imagem de marca
da empresa. O termo "photoshop” também € usado como substantivo
relativamente a imagem alterada. Sdo termos populares utilizados por
membros de sites como "Something Awful", "Fark.com”, "B3ta" ,"Desafios
Photoshop Brasil" e "Worth1000". O objectivo de alterar uma imagem é torna-la
humoristica ou inteligente, muitas vezes através de referéncias a piadas e a
culturapop. Numa vertente mais recente neste ambito € a
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chamada fake (traduzida por falso), em que se alteram imagens parodiando
figuras célebres, com imagens de nus ou pornogréficas. Surgiram até
concursos de Photoshop em que profissionais e amadores competiam para
mostrar as suas capacidades de edicdo de imagens nestas vertentes.

O termo é também por vezes utilizado por artistas, para se referir a imagens
qgue tenham sido retocadas (retouched) ao invés das imagens originais. Um
problema comum entre os varios tipos de utilizadores do Photoshop € evitar
gue os seus trabalhos se parecam com o "aspecto Photoshop" (intrinseco entre
todos os programas de edicao de imagem).

Também recentemente, o Photoshop é usado para alterar e desenhar veiculos,
normalmente carros, processo esse, denominado por digi-
modding, photoshopping ou tuning virtual. J& sdo muitos o0s sites que se
dedicam a este aspecto, e este novo tipo de "arte" tem-se expandido. E apesar
dos sites, permitirem as pessoas mostrarem 0sS seus carros, publicamente na
internet, os carros manipulados digitalmente ja existem ha muito tempo nas
revistas de automoveis.

Formato PSD

Formato padrdo da Adobe para documentos do Photoshop. Possui muitos
recursos extras como imagens por camadas. Este formato é suportado por
pouquissimos programas fora o Adobe Photoshop.

Existem muitos outros editores de imagens bitmap disponiveis, mas nenhum
deles conseguiu a popularidade do Adobe Photoshop entre os profissionais. Os
concorrentes mais utilizados noutros mercados-alvo sdo o GIMP open-source,
j& com muito utilizadores; e os pacotes de programas comerciais, como Corel
Photo-Paint, PhotoFiltre e Paint Shop Pro.

Entre outras alternativas menos conhecidas, pode-se destacar
o0 GIMPshop (uma versdo do GIMP com uma interface grafica semelhante ao
Photoshop), o paint.net, o Pixel32 disponivel em mais plataformas do que os
outros programas comerciais, o PhotoFiltre, excelente alternativa gratuita para
uso nao-comercial, e o PhotoScape que esta fazendo um enorme sucesso pela
sua facilidade de uso.

Atualmente a versdo mais recente € o Photoshop CC (Creative Cloud, 14.0),
lancada em junho de 2013, essa versdo ndo apresenta grandes evolucdes
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comparado a sua antecessora, porém ao comparar com a primeira versao o
Photoshop 0.63 foram adicionadas muitas funcionalidades importantes como:

Implementacao de Paths que permite o desenho vetorial,
Selec¢éo de objetos mais precisa;

Content-Aware: ferramenta que remove itens desejados baseando-se nos
dados ao redor dele;

Possibilidade de ver os pincéis em 3 Dimensdes e ver como reagem com a
pintura;

Paletes tabuadas;

Camadas ajustaveis;

Tipo de Letras editaveis;
Texto totalmente vetorial;

O uso de filtros;

Figuras geométricas vetoriais;
Histograma em tempo-real,

Incrementacdo do recurso de criagéo, edicao e pintura de "objetos 3D".

A Adobe também oferece uma versdao mais simplificada do seu produto,
chamada de Photoshop Elements, que apesar de n&do possuir grandes
recursos, consegue obter bons resultados, o programa tem como publico alvo
0s usuarios domesticos. Para os usuarios que querem editar fotos em seus
dispositivos méveis a empresa fornece as versdes Express, Fix e Lightroom.

Instalacao (Verséao Trial)

Para realizar a instalacdo sera usado o Photoshop CS6 Master Collection,
disponivel no site da Adobe. Siga 0 passo a passo a seguir para realizar a
instalacao (na plataforma Windows).

1. Faca o download do(s) arquivo(s) no site da Adobe e armazene em uma
pasta, como mostra a figura 1.1, escolha conforme o seu sistema operacional.



2. Ap6s o download , execute o arquivo “MasterCollection_CS6_LS16.exe”. A a
janela apresentada na figura 1.2 deve abrir, nela escolha o local onde sera
instalado o programa e entdo clique em “Avancgar”, ira aparecer uma barra de
progresso como na figura 1.3.

3. Como o Photoshop € um software pago, apdés a conclusdo da etapa 2,
escolha a opcdo de “Avaliar’, como mostra na figura 1.4. Caso vocé tenha
comprado o software, escolha a opcgao “Instalar’, onde sera solicitado um
namero de série.

4. Nessa etapa sera apresentado o contrato de licenca do software, como na
figura 1.5, Caso concorde, clique no botdo “Aceitar”, para seguir com a
instalacao.

5. Nessa etapa serd solicitado o ID de usuario da Adobe, caso ndo possua, crie
um através do botao “Criar uma Adobe ID”. Se ja possuir, preencha os campos
necessarios e aperte “Entrar”.

6. Nessa etapa vocé deve escolher quais softwares vocé vai instalar. Como o
foco deste tutorial € o Photoshop, marque a opcao dele e clique em “Instalar”,
na figura 1.7 mostra as opcoes ja selecionadas.

7. Espere a conclusao da instalacdo como apresenta a figura 1.8.

8. Apos a conclusdo de todas as etapas anteriores, seu PhotoShop estara
pronto para o uso. Agora basta clicar em “Fechar”, como na figura 1.9 e pronto.

Quando vocé abre o Photoshop CS6, sera apresenta sua tela inicial, Nesta tela
estao dispostas diversas ferramentas.




Na parte superior da tela, encontra-se a Barra de ferramentas. Nesta barra é
possivel realizar as fun¢des bésicas do programa, assim como gerenciar
configuragbes gerais do mesmo.

No lado direito encontram-se os Painéis do Photoshop, para abrir novos painéis
basta ir em Windows e marcar agqueles que deseja exibir.

Adjustments
Add an adjustment

Ja no lado esquerdo do ambiente de trabalho aparecera o Painel Ferramentas,
algumas dessas ferramentas tém opcdes que aparecem na barra de opc¢bes
sensiveis ao contexto. Essas ferramentas podem ser expandidas,
apresentando suas derivadas, para isso basta clicar com o botdo direito do
mouse sobre o icone.

Extensdes nativas

Extensdes nativas sdo utilizadas para salvar projetos em andamento ou
guando se deseja salvar todas as informagfes da imagem criada, sdo feitas
para suportar multiplas camadas de todos os tipos existentes no Photoshop,
como camadas de texto, camada de efeitos, etc. As opgdes nativas sdo:



PSD: este tipo de arquivo suporta informacées sobre qualquer
arquivo/ferramenta photoshop de até 2GB, ideal quando se trabalha com
pequenas imagens.

PSB: semelhante ao PSD, porém suporta imagens de maior peso, sendo a
escolha certa para projetos com mais de 2GB os quais se deseja manter a
gualidade da imagem. A extensdo PSB foi implementada na versdao CS do
Photoshop, portanto ndo é suportada em versdes anteriores.

Formatos de Impresséo

Tanto designers web quanto profissionais em criagdo de materiais impressos
utilizam de diversos formatos diferentes de arquivos, para assim chegar em um
resultado adequado para cada tipo de imagem que se deseja. O photoshop é
compativel com varias extensoes, sendo GIF, JPG, PNG, EPS, TIFF e PCX as
mais utilizadas.

Segue algumas dicas para uma boa escolha de extensdes:

GIF: € um formato pequeno de imagem, podendo conter apenas 256 cores,
fazendo com que sejam utilizados apenas para graficos ou imagens com
poucas cores.

JPG: é um formato bom para salvar imagens complexas, ja que comporta 16
milhdes de cores, porém utiliza um algoritmo com perdas para a compactacao
da imagem, o que lhe faz pouco util em casos em que se deseja salvar 100%
das informacdes contidas na imagem.

PNG: pode ser salvo com diversas profundidades de bits e utiliza um algoritmo
de compressao sem perda, 0 que se torna util para imagens que devem ser
mantidas intactas, porém pode deixar o arquivo mais pesado. Além disso, esse
formato permite salvar imagens com fundo transparente.

EPS, TIFF, PCX: utilizados principalmente para imagens em alta resolucéao.

PDF: utilizado para imagens que devem conter algum tipo de seguranca contra
alteracao.

Para mudar o formato da imagem que esta sendo editada no Photoshop basta
clicar no menu Arquivo > Salvar como.



Ira abrir uma janela, onde se pode escolher o diretério em que a imagem sera
salva e a extensdo que a mesma tera. Clicando no item Tipo séo abertas as
opcOes possiveis para salvar a imagem.

As camadas séo parte essencial no processo criativo no Adobe Photoshop,
pois organizam de forma logica os elementos e efeitos que utilizamos nas
composicdes e sao acessadas pelo painel “Camadas”. As fungdes para
Camadas permite "empilhar" elementos dentro de uma composi¢cdo de modo
que seja possivel ter um controle individual para cada camada aplicada em
uma unica imagem. Esse recurso revolucionou o modo de editar imagens
digitalmente. A flexibilidade sem precedentes das funcionalidades para
manipulacdo de imagens em camadas levou 0s usuarios a uma experiéncia
similar a arte tradicional, como nas mesas de animacédo, onde a sobreposicdo
de folhas de acetato permitia editar partes especificas da composicéo,
mantendo-as separadas. Como falado anteriormente, pode-se compreender o
funcionamento das camadas no Photoshop, através de uma analogia a folhas
de acetato. Imaginemos varias folhas de acetato empilhadas, cada uma com
algum desenho diferente — provavelmente esta foi a grande inspiracédo para a
criacdo do recurso.

O Photoshop oferece inimeros efeitos como sombra, brilho e texturas que
alteram a aparéncia do conteudo de uma camada. Os efeitos de camada sao
vinculados ao conteado. Ao mover ou editar o conteudo da camada, o0s
mesmos efeitos sdo aplicados no conteudo modificado. Por exemplo, se uma
sombra projetada for aplicada a uma camada de texto e, em seguida, um novo
texto for adicionado, a sombra sera adicionada automaticamente ao novo texto.
O estilo de camada € um ou mais efeitos aplicados a ela ou a um grupo de
camadas. Para aplicar estilos, usamos a caixa de dialogo Estilos de Camada,
gue pode ser aberto com dois cliques na camada, ou através do botéo direito
do mouse e “Opc¢des de Mesclagem” (ou Blending Options). Entre as opcdes
de estilo estdo a "Sombra projetada” os "Brilhos interno e externo”, efeito
"Acetinado"”, aplicar uma "sobreposicédo de cor ou degradé”, e muito mais. E
possivel combinar e adicionar multiplos estilos em uma uUnica camada do
projeto.

Ferramenta Mover (Shift+V)

Com a ferramenta mover podem ser realizadas as operacfes de mover uma
camada e duplicar uma camada, desde que elas nao estejam bloqueadas.



1. Para desbloguear uma camada é preciso dar dois cliques no cadeado que
tem na camada, no canto direito e em seguida, clicar em “Ok", ou se disponivel,
no cadeado acima de todas as camadas.

2. Para mover o conteudo de uma camada basta selecionar a sua camada,
segurar o com o botdo esquerdo do mouse e arrastar para onde desejar.

O Adobe Photoshop é um dos editores de imagens mais populares em todo o
mundo, inclusive dentre os brasileiros. Para conhecer as ferramentas, 0s
internautas podem baixar uma versao de testes gratis, que funciona por 30
dias. A versao trial do CS6 esta disponivel para download no site oficial e para
usar é necessario fazer um cadastro rapido com o ID da Adobe.

Download e Instalacao

Passo 1. Acesse a pagina de downloads da Adobe (adobe.com/br/x-productkb/)
para encontrar a versdo CS6 do Photoshop, ja que ela é mais antiga. Role a
tela até a opgao “Photoshop CS6" e clique no link para baixar os dois arquivos
com idioma em portugués (com 1,1 GB e 1 MB);

Passo 2. Depois de baixar, encontre a pasta o arquivo mais leve, com 1 MB
chamado de “Photoshop 13 LS4" e clique duas vezes nele. O Photoshop
comecara a ser descompactado para instalacdo no computador.

Passo 3. Ao descompactar sera gerada uma pasta com o titulo de “Adobe CS6"
na area de trabalho. Selecione a subpasta “Adobe” e depois “Adobe CS6".
Complete clicando duas vezes no arquivo “Set-up.exe” para iniciar a instalagao

Passo 4. Clique no botao de “instalar uma versao de avaliagao” (que € a trial de
testes) e confirme em “Aceitar’

Passo 5. Clique em “Entrar” caso o programa ja identifique sua Adobe ID ou
inscreva-se para acessar, adicionando os dados pessoais.

Passo 6. Selecione a caixa de texto ao lado da versdo do Photoshop que
deseja instalar, confirme o idioma em portugués e clique em “instalar’. O
procedimento pode demorar alguns minutos; ao final sera mostrada uma
mensagem de concluséo. Finalize no botao “fechar”.


http://www.techtudo.com.br/tudo-sobre/adobe-photoshop.html
http://www.techtudo.com.br/tudo-sobre/adobe.html
https://helpx.adobe.com/br/x-productkb/policy-pricing/cs6-product-downloads.html

Photoshop CS6

Passo 1. Ao abrir o Photoshop CS6 pela primeira vez sera exibida uma tela
com o tempo de trial para testes (30 dias). Clique no botdo “Iniciar versao de
avaliacdo” para comegar a usar o programa

Passo 2. O Photoshop é um programa completo para edi¢cdo de imagens. Para
entender a interface, no topo ha uma barra para encontrar filtros, ajustes, salvar
arquivos e tudo o que diz respeito a configuracdes

Arquivo  Editar Imagem Camada Tipo Selecionar Filtro 3D Visualizar Jlanela Ajuda
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Passo 3. Na lateral esquerda esta a barra de ferramentas, para controlar os
itens adicionados na edi¢cdo. Assim, é possivel arrastar imagens, aplicar cores,
textos, recortar a foto, remover o fundo e mais recursos.
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Passo 4. Na lateral direita estdo as layers (ou camadas) e tudo o que for
adicionado durante a edicdo aparecerd nesta janela. No topo direito ha atalhos
para ajustes de brilho, contraste, cor e efeitos

Passo 5. Para facilitar o uso, estao disponiveis estilos para cada atividade, que
mostram as ferramentas em atalhos. Para acessar, cligue no menu no topo
direito da tela. H4 opc¢éo para pintura, 3D, movimento, tipografia e até itens
para personalizar.

O Photoshop é uma ferramenta incrivelmente poderosa, mas ndo da pra negar
gue ela bota medo em quem nunca usou. Se vocé sempre quis aprender a usar
Photoshop, mas ndo sabia por onde comegar, seja bem vindo. O video acima é
a sua aula. Ele é longo se considerarmos que esta na internet, mas € curto se
considerarmos todos os topicos que ele cobre.



No6s ndo vamos ver todas as ferramentas individualmente, mas boa parte delas
estao abaixo. Este resumo vai te dar uma boa ideia do que cada uma faz, mas
ndo deixe de encontrar alguma foto e usa-las na pratica.

X

Mover (Atalho: V)

A ferramenta Mover permite que vocé mova objetos em uma determinada

camada. Para usa-la, cligue em qualquer lugar da tela e arraste. O objeto
selecionado se movera na camada.

Letreiro (Atalho: M)

A ferramenta Letreiro tem uma traducéo esquisita. Uma traducdo muito melhor,
na minha opini&o, seria “Selecédo por Area”. De qualquer forma, ela serve para
selecionar uma porcéo da tela no formato retangular ou eliptico. A selecéo é a
parte da imagem que sera afetada por qualquer edicdo que vocé fizer
posteriormente. Segurando Shift ao fazer a selecéo, vocé obtém um quadrado
ou circulo perfeito.

A Laco (Atalho: L)

O Laco é uma ferramenta de selecdo livre que permite a vocé desenhar uma
area de selecdo com o mouse, enquanto mantém o clique pressionado. Ao
fechar a forma, tudo que estiver dentro dela, estara selecionado. Dentro desta
mesma ferramenta vocé ainda tem acesso ao Laco Poligonal, que permite criar


http://www.flickr.com/creativecommons/by-2.0/
http://www.gizmodo.com.br/files/2011/02/01-move-tool.jpg
http://www.gizmodo.com.br/files/2011/02/02-selection-tools.jpg
http://www.gizmodo.com.br/files/2011/02/03-lasso.jpg

uma selecao livre em varios cliques, e 0 Lago Magnético, que tenta detectar
bordas automaticamente para facilitar a sua selegao.

Varinha Magica (Atalho: W)

A Varinha Magica € mais uma ferramenta de selecdo. Ao seleciona-la e clicar
em uma area da imagem, vocé diz ao Photoshop que deseja uma selecao que
inclua o ponto clicado e todas as areas adjacentes com coloracdo similar (ha
um ajuste no topo da tela para determinar a sensibilidade dessa medicédo de
area similar). A Varinha Magica é geralmente utilizada como uma forma
amadora de retirar fundos de imagens.

- Corte (Atalho: C)

A ferramenta de Corte € usada para — surpresa! — cortar as suas imagens.
Vocé faz uma selecédo retangular, e tudo que ficar de fora dessa selecao sera
eliminado da imagem. E possivel especificar o tamanho exato do corte, ou uma
proporcao, assim como cortar a mao livre.

Conta-gotas (Atalho: 1)

A ferramenta Conta-gotas permite que vocé clique em qualquer parte da tela
para copiar a cor do local clicado. Ao copiar a cor, o Conta-gotas alterara a cor
primaria que vocé estiver usando para a cor copiada. Esta ferramenta facilita


http://www.gizmodo.com.br/files/2011/02/04-magic-wand.jpg
http://www.gizmodo.com.br/files/2011/02/05-crop-tool.jpg
http://www.gizmodo.com.br/files/2011/02/06-eyedropper-tool.jpg

enormemente na hora de escolher uma cor exata que ja exista na imagem, em
vez de ter que escolher no seletor de cores.

Pincel de Recuperacéo: (Atalho: J)

O Pincel de Recuperacao deixa vocé pegar uma amostra de um ponto da
imagem e usa-lo para pintar sobre outro ponto dela. Quando vocé terminar, o
Photoshop vai examinar a regido ao redor da que vocé pintou para tentar
suavizar a sua edicao.

Pincel e Lapis (Atalho: B)

O Pincel e o Lapis sdo ferramentas de desenho que atuam como 0S seus
nomes sugerem. O lapis cria uma linha dura de espessura variavel, enquanto o
pincel pode assumir centenas de formatos formatos e modelos diferentes, e
geralmente produz uma linha mas suave.

Carimbo (Atalho: S)

Como o Pincel de Recuperacdo, o Carimbo permite que vocé determine uma
parte da imagem como origem de amostragem e entdo use esta amostragem
para cobrir outra area. No entanto, com o Carimbo a coisa para por ai. O
Photoshop néo fara nada para suavizar a sua correcao.


http://www.gizmodo.com.br/files/2011/02/07-healing-brush.jpg
http://www.gizmodo.com.br/files/2011/02/08-paintrbrush-and-pencil.jpg
http://www.gizmodo.com.br/files/2011/02/09-clone-stamp.jpg

Pincel do Histérico (Atalho: Y)

O Pincel de Histdrico permite que vocé “pinte o passado”. O Photoshop salva
todas as etapas da sua edi¢cdo (bem, por padrao sdo apenas 50 etapas), e 0
Pincel de Histérico é capaz de pintar o passado sobre a imagem atual.
Digamos que vocé aumentou o brilho da imagem inteira, mas gostaria que um
pedaco dela voltasse a ficar escuro como estava antes. Nesse caso, vocé pode
selecionar o Pincel do Histdrico e a etapa do histérico que representa a
imagem como Vocé quer que ela volte a ser, entdo pintar a parte desejada para
trazer de volta a forma antiga.

Borracha (Atalho: E)

A Borracha é uma ferramenta praticamente idéntica ao pincel, com a vital
diferenca de que ela apaga em vez de pintar. Ao apagar, pode acontecer da
regiao apagada adquirir uma cor “estranha”. Isso se da porque a Borracha
preenche o plano de fundo da area apagada com a cor de plano de fundo
selecionada (ver “Ferramentas de Selecao de Cor” abaixo).

- Lata de Tinta e Gradiente (Atalho: G)

A Lata de Tinta funciona da mesma maneira que a Varinha Magica, no sentido
de que atua sobre a area clicada e as areas similares ao redor, mas, em vez de
selecionar, ela pinta com a cor primaria ativa. A ferramenta Gradiente pega as


http://www.gizmodo.com.br/files/2011/02/10-history-brush.jpg
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cores primarias e de fundo ativas e clica um gradiente entre elas, mas também
pode ser usada para criagdo de gradientes bem mais complexos, envolvendo
transparéncias e mais de duas cores.

Desfoque, Nitidez e Borrar (Atalho: nenhum)

Estas trés ferramentas funcionam como pincéis, mas cada uma tem um
impacto diferente na sua imagem, bastante auto-explicativos. A ferramenta
Borrar € muito Gtil para em desenhos, para fazer cores com transi¢cdes suaves
ou para fazer elementos como fumaga.

Subexposicéo, Superexposicao e Esponja (Atalho: O)

Estas sdo mais alguns exemplos de ferramentas do tipo pincel, que manipulam
luminosidade e intensidade de cores. A primeira serve para escurecer areas da
foto, enquanto a segunda serve para clarear, e a terceira serve para saturar ou
suavizar cores na area pintada por ela. Sdo ferramentas muito Uteis para
retoques em fotos.

Caneta (Atalho: P)


http://www.gizmodo.com.br/files/2011/02/13-blur_-sharpen_-and-smudge.jpg
http://www.gizmodo.com.br/files/2011/02/14-burn_-dodge_-and-sponge.jpg
http://www.gizmodo.com.br/files/2011/02/15-pen.jpg

A ferramenta Caneta é usada para desenhar gréaficos vetoriais. Também pode
ser usada para criar demarcadores que podem ser usados para varias tarefas
mais avancadas.

Ferramenta Texto (Atalho: T)

Com esta ferramenta, vocé pode escrever horizontalmente. Com as
ferramentas escondidas abaixo desta, vocé consegue escrever verticalmente e
também criar mascarasde texto horizontais e verticais.

Selecdo de Demarcador (Atalho: A)

Esta ferramenta permite mover qualquer demarcador criado. E igual a
ferramenta Mover, mas apenas para demarcadores.

o Formas (Atalho: U)

Estas quatro ferramentas permite criar retangulos, elipses, poligonos, linhas e
formas personalizadas em formato vetor. Estas formas sdo muito Uteis quando
se esta desenhando ou criando mascaras geométricas para fotos.


http://pt.wikipedia.org/wiki/Desenho_vetorial
http://www.digitalscrapbookplace.com/university/tutorials/ps_layermasks.shtml
http://www.gizmodo.com.br/files/2011/02/16-type.jpg
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Al

- Ferramenta Mao (Atalho: H)

Esta ferramenta permite mover a sua visdo da area de trabalho inteira do
Photoshop. Se a imagem que vocé esta trabalhando cabe inteira na tela do seu
computador, esta ferramenta ndo serve para nada. Ela é util para mover a sua
visdo quando vocé esta trabalhando em uma imagem super aproximada com a
ferramenta Zoom. Dica: a Mao pode ser selecionada temporariamente
segurando a tecla Espaco. Quando vocé soltar o Espaco, estard novamente
com a ferramenta anterior selecionada.)

Zoom (Atalho: Z)

A ferramenta Zoom € usada para aproximar e afastar a imagem, afim de
trabalhar diretamente nos pixels individuais ou em uma pequena area. Por
padrdo, a ferramenta Zoom sé aproxima. Para afastar, clique com a tecla
Option/Alt. Ou use a roda do mouse para afastar e aproximar mais
rapidamente.

oY
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Ferramentas de Selecdo de Cor (Teclado: D para padrdes, X para inverter as
cores)

Estas ferramentas permitem escolher e gerenciar as cores que vocé esta
usando. A cor de cima é a sua primaria, enquanto a de tras é a cor de plano de
fundo. A cor priméria é a que serd usada pelos pincéis. A cor de plano de fundo
entra em agao quando vocé deletar ou extender algo do plano de fundo (apesar
de que agora, no Photoshop CS5, é possivel usar a cor primaria em algumas
circunstancias. Os dois icones menores acima das cores sdo atalhos de
funcdes. O da esquerda, que mostra um quadrado preto sobre um branco,
configura as suas cores primaria e de plano de fundo para os padrdes, que sao
preto e branco (vocé também pode usar o atalho D). A seta curva com duas
pontas a direita troca as suas cores uma pela outra (atalho: X). Clicar em
gualquer uma das cores abre um seletor para que vocé escolha com precisdo a
cor que quer usar agora.

O layout do Photoshop por exemplo vem mantendo sua base desde sua
primeira versao, justamente para ndo confundir muito 0S USuarios.

Uma prova real desta base é a barra de ferramentas que fica localizado no lado
esquerdo.

Observe como estas barras conservam uma sequéncia do seu layout a cada
nova versdo, até mesmo quando uma nova ferramenta é adicionada ou
retirada.
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A interface do Photoshop

O Photoshop CC 2017 trouxe mudancas interessantes nesta nova versao,
principalmente na tela principal, onde o usuario agora pode visualizar as
tltimas imagens que foram abertas no aplicativo, assim como botBes
de Criar e Abrir novos documentos.

Existe a opcdo de organizar estas Ultimas imagens abertas
por: Nome, Tamanho, Aberto pela ultima vez ou Tipo.

Outro ponto de destaque é a opcdo de visualizacdo destas imagens. Vocé
escolhe se deseja ver em lista ou miniaturas.

Barra de controle

Em uma visdo rapida, a barra de ferramentas oferece 65 opc¢des de
ferramentas para o usuario trabalhar em suas fotos.



Ao ativar qualquer uma destas ferramentas, vocé vai visualizar que uma barra
na interface do Photoshop vai ficar mudando.

Esta barra em especial € chamada de: Barra de controle.
Sua finalidade € apresentar recursos extras das ferramentas selecionadas.
Vejamos um exemplo:

Ao ativar a ferramenta Letreiro retangular eu sei que posso fazer uma selecéo
em qualquer area da imagem em formato quadrado.

Até este ponto ndo tem nada de estranho.

A funcdo da barra de controle passa a fazer sentido quando dentro de uma
selecdo ja criada ocorre a necessidade de fazer uma nova selecéo.

Para que esta acao ocorra € necessario ativar na barra de controle uma funcéo
extra da ferramenta Letreiro Retangular chamada Adicionar a selecdo para que
0 usuario possa realizar o trabalho.

Paletas

As paletas sdo os painéis que vocé vé na parte direita da tela. Eles facilitam
acOes como navegar pela imagem, fazer alguns ajustes, alternar entre modos e
outras coisas muito Uteis. Se quiser se livrar de alguma que considere
desnecessaria, ou principalmente trazer uma paleta que ndo esteja
aparecendo, use o Menu Janelas, e, se for necessario, arraste com o mouse
para a area de paletas a direita.

W Drop Shacow

v winls Camadas

A paleta de camadas é provavelmente o coracdo da edicdo de imagens. Ela
mostra todas as diferentes camadas do seu documento, na ordem. Vocé vai
usar esta paleta mais do que qualquer outra. Nela vocé vai organizar e ordenar
as suas camadas, assim como configurar modos de mistura, visibilidade e
opacidade, agrupar e fundi-las umas com as outras, além de uma porcdo de
coisas mais avangadas.


http://en.wikipedia.org/wiki/Blend_modes
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Ajustes

O painel de ajustes € onde vocé pode facilmente criar e editar camadas de
ajustes. Estas camadas de ajustes sao alteracbes néo-destrutivas que afetam
todas as camadas abaixo delas e que podem ser facilmente ligadas ou
desligadas. O seu uso mais comum é para corre¢ao de cores (especificamente
os ajustes de Niveis e Curvas), mas ha muitos ajustes diferentes que vocé
pode fazer para alterar dramaticamente o visual da sua imagem.
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A paleta de Canais de Cores permite analisar de modo separado as diferentes
cores que formam a sua imagem. Se vocé estiver em modo RGB, tera os
canais vermelho (R), verde (G) e azul (B). Estes canais vao se modificar se
vocé estiver usando um espaco de cores diferente, como CMYK ou LAB.
Quando vocé escolher uma cor especifica, vai notar que a sua imagem sera
mostrada em diferentes versdes de preto e branco. Isso é porque cada canal
de cor € apenas uma imagem monocromatica representando a luz em cada
canal (ou seja: o canal vermelho mostra apenas a quantidade de luz vermelha
gue a imagem emite nos diferentes pontos dela). Alternar entre esses canais
diferentes é Util para fazer retoques especificos em cada canal de cor,
melhorias gerais de contraste e também para converter a sua foto para uma
versao preto e branco de modo mais correto.
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Esta paleta permite alterar suas cores priméria e de plano de fundo de maneira
mais fécil, usando comandos deslizantes com os valores individuais RGB (ou
do espaco de cor que voceé estiver utilizando).

il

Amostras de Cores

A paleta de amostras de cores é um conjunto de cores pré-definidas que vocé
pode escolher rapidamente. E possivel carregar diversas outras colecbes de
amostras, ou criar a sua propria.

| HISTORY

A paleta de histérico permite ver as ultimas etapas da sua edicao, e retornar a
alguma delas caso vocé queira. O comando Desfazer (Ctrl+Z) tem como
padrdo apenas alternar entre o Ultimo e o penultimo estado do histérico. Para
voltar mais etapas, € por aqui que vocé chega la (até o maximo de 50 acdes,
por padrao).
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A paleta de Texto, e a sua companheira Paragrafo, permitem fazer todo o tipo
de ajuste necessario as suas camadas de texto. Estas opc¢des sdo bem
similares as que vocé encontra em um editor de texto como o Word, mas vocé
também pode especificar coisas como espagamento entre letras e entre linhas,
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assim como largura relativa dos caracteres, que sao ajustes mais Uteis no
mundo do design.

Menus

Selecthnalysis 3D View Window
Gaussian Blur 3BF

v  Nomat  Convert for Smart Filters

Filter Gallery...

Lens Correction... (3R
Liquify... o8X
Vanishing Point... X3V
Artistic >
Blur >
Brush Strokes >
Distort >

Muito do que vocé encontra nos menus do Photoshop pode ser feito com as
ferramentas que ja vimos. Ainda assim, vamos dar uma olhada rapida das
principais op¢fes de cada menu.

Arquivo

Como de costume, o menu Arquivo lida com abrir, salvar e fechar arquivos.
Uma opcéo diferente e de destaque é a Salvar Para Web, que € muito util para
a funcao indicada pelo proprio nome.

Editar

Outro menu que previsivelmente funciona como em muitos outros programas, o
Editar traz recursos como desfazer, refazer, cortar, copiar e colar. No
Photoshop, é aqui que vocé transforma suas camadas e define seu espaco de
cores.

Imagem

Ajustes de imagem e de tela, incluindo efeitos destrutivos que vocé também
pode encontrar na paleta Ajustes. As opcdes neste menu sao feitas para alterar
a sua imagem como um todo, apesar de alguns ajustes serem aplicados
apenas a uma camada.

Camada

O menu Camada permite fazer todo tipo de coisa que vocé faria pela paleta
Camadas, com algumas opg¢les extras. Este menu também permite a criagdo
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de camadas de ajuste e objetos inteligentes (um grupo de camadas tratado
como um objeto Unico).

Selecionar

As ferramentas Letreiro e Lago serdo seus principais meios de selecionar
partes da sua imagem, mas 0 menu Selecionar ajuda a refinar a sua selecéo.
Também pode ser usado para criar sele¢cdes completamente novas a partir de
critérios como espectro de cor e luminosidade.

Filtro

O menu Filtro traz uma colecdo de filtros inclusos no Photoshop (é possivel
instalar mais filtros de terceiros), que podem borrar, focar, distorcer e alterar a
sua imagem (ou algumas camadas apenas) de muitos modos diferentes e
unicos. A melhor maneira de conhecer os filtros é experimenta-los todos. Isso
pode tomar um pouco de tempo, mas € divertido brincar com eles e ver o que
conseguem fazer.

Analise

Aqui vocé encontra ferramentas de medicdo. Havera ocasifes em que vocé
precisara delas para fazer alteracdes precisas em suas imagens, mas isso tudo
€ Photoshop avancado.

3D

Assim como 0 menu anterior, este aqui contém controles para manipulacao de
objetos 3D que sdo avancados o bastante para que ndo valha a pena entrar
nos seus méritos. No entanto, encorajamos VOCé a experimentar com eles e
aprender o que puder.

Visualizar

Este menu oferece diversas opcdes de visualizacdo da sua area de trabalho. E
possivel exibir ou esconder guias e réguas e fazer com que o Photoshop
automaticamente alinhe objetos em relacdo a bordas, cantos e ou uma grade
no plano de fundo. A exibicdo desta grade também pode ser ligada e desligada
neste menu.

Janela

O menu Janela permite esconder e mostrar certas janelas e paletas. Vocé
também pode organizar as suas janelas do Photoshop do jeito que quiser, e
salvar a sua organizacao para carregar posteriormente. E isso é tudo que vocé
precisa saber sobre o basico do Photoshop.



Duplique a camada da imagem (ctrl+j)

vA em menu superior > filtro > desfoque(Blur) > Desfoque
graussiano(Graussian Blur) Ajuste para 10px a 15px de ok!

Va4 em modos de mesclagem e selecione Sobrepor(Overlay). Se ficar muito
forte ajuste a opacidade para em torno de 80%.

Super simples mais com efeito de impacto e perfeito para restaurar a cor.
Nessa técnica o que fard vocé se diferenciar de um amador € saber dosar a
opacidade da camada.

Variacdes da ferramenta pincel de recuperagdo de manchas [healing brush]

J& Ferramenta Pincel de Recuperacdo para Manchas

;:& Ferramenta Pincel de Recuperacao
-

i m {j} Ferramenta Correcdo

=L 2¢ Ferramenta Mover sensivel a contetido
-

acy -+ Ferramenta Olhos Vermelhos

copiar a area ao redor (automatico)

copiar a partir de uma area que eu selecionei- click a tecla ALT sobre a area
gue voce quer, depois solte e use normalmente a ferramenta.

Versao para usar em regidées maiores, como se fosse a ferramenta selecao.

Sensivel ao conteddo ou seja sensivel ao que estiver em qualquer um dos
lados do pincel.

Remover olhos vermelhos- ajuste o tamanho do pincel, para ser igual ao
tamanho do olho e de um click em cima.

Habilidades:

Como retocar pele photoshop com efeito natural e sem deixa a modelo com
cara de boneca!

Como wusar efeito Dodge(Subexposicdo) e Burn(Superexposicao) do
photoshop.
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Como usar a ferramenta esponja do photoshop.
Aplicacao correta desses efeitos em fotografias para retocar pele photoshop.

Passo 01— Remover as impurezas e limpar a imagem com ferramenta pincel de
recuperagao para remover espinhas cravos, olheiras e manchas no geral. Essa
vai sei nossa base para comecar o retoque, eu ja expliquei no tutorial 02 Como
remover espinhas montanhas e outras coisas, tudo sobre essa ferramenta caso
vocé ndo a conheca € s6 assistir o tutorial anterior.

. 59 Ferramenta Pincel de Recuperacdo para Manchas

é@ Ferramenta Pincel de Recuperagdo

44 Ferramenta Correcdo
2 Ferramenta Mover sensivel a contelido

+ Ferramenta Olhos Vermelhos

Passo 02- Equilibrar a luz e sombra com Dodge e Burn realgcando as areas de
luz e sombra da modelo. Esse passo é muito importante para restaurar
detalhes como sobrancelha falhadas, luz dos olhos e outros detalhes da foto. E

va delicadamente restaurando as sombras e luzes do rosto.

Photoshop

A ferramenta: Dodge ou Subexposicao

Ela é um pincel que cria literalmente um spot de luz, ao nosso dispor para
iluminarmos todos as areas que quisermos! Isso mesmo ela adiciona luz!. No
entanto temos que ter cuidado, que por ela ser baseada na exposicao de luz o
excesso dela causa intensa saturacdo na foto por isso eu indico o uso com
exposicao a 20% no maximo.

A ferramenta: Burn ou Superexposic¢ao

Ja a ferramenta Burn faz exatamente o contrario, enquanto o Dodge cria
literalmente um spot de luz, o burn cria efeito de escuriddo! No entanto também
temos que ter cuidado, por ela ser baseada na luz também o excesso dela
causa desaturacdo extrema na foto por isso eu indico 0 uso com exposi¢cao a
20% no maximo também.



Dica de Ouro

O mais importante ao usar essa técnica € paciéncia e leveza, ndo adianta
querer fazer tudo correndo que né&o vai funcionar! Faca com a opacidade baixa
sempre que ndo tem erro.

Passo a passo:

Passo 01: Use a ferramenta conta gotas (alt) para selecionar cor exata do
dente.

Passo 02- Use a ferramenta pincel e pinte sobre o aparelho.

Passo 03- Para clarear use a ferramenta esponja e passe apenas na area do
dente.

Passo a passo:

Passo 01: Recorte a foto com a ferramenta a ferramenta caneta, porque ela é
mais precisa e isso fara toda diferenca. Selecione a ferramenta e va clicando
ponto a ponto em torno da modelo bem rente ao corpo. Depois clique com o
esquerdo e va em criar selecao de ok. E de ctrl+j para duplicar e o recorte esta
pronto.

Passo 02- Use a ferramenta dissolver(ou liquify se seu photoshop for inglés) e
va com delicadeza afinando os bracos, e trabalhando as curvas da cintura sem
exagerar d+ para ndo parecer falso. Tente transforma-la em uma modelo plus
size linda por exemplo em vez de uma modelo de passarela

Passo 03- Use o pincel de recuperacdo e elimine todas as areas flacidas da
modelo.

Passo 04- Use o Dodge(Subexposicéo) e Burn(Superexposicao) para restaurar
as sombras e luzes. Quando fazemos retoques grandes assim é sempre bom
dar uma retocada na iluminacdo até porque a ferramenta dissolver é bem
drastica e pra destruir a iluminacdo com ela € muito facil!

Entdo use o esses pinceis proprios de iluminacéo para realcar areas de sombra
e luz, sempre com a opacidade a 20px no maximo.

Ferramenta: Dissolver (Liquify) do photoshop

A ferramenta Dissolver foi criada para nos dar liberdade para distorcer,
transformar, alargar ou achatar qualquer imagem, e até reconstruir partes da
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foto distorcida nenhum outro software tem uma ferramenta capaz de criar
distor¢des extremas assim! Por isso ela ficou bem famosa no mundo inteiro e
principalmente no mundo das capas de revistal Por edicdes mal feitas e
grosseiras. E como dizem poder em mé&os erradas ¢ destruicio

Concentre-se em usar a ferramenta dissolver para criar simetria na foto, se um
braco esta gordo por exemplo ndo tente deixar ele como o da gisele Biindchen.
Procure apenas deixa-lo reto sé isso ja da outra impressdo para a foto entdo
amelhor dica que eu posso te dar € tente criar simetria em vez de milagre

O retoque completo — Retoque de pele + Retoque de luz + Retoque de cor.

Tratamento de foto + Make no photoshop com ar natural e realista? Sera
possivel?

Eis um grande dilema para os photoshopers, com as infinitas possibilidades do
photoshop é dificil escolher uma tecnica que seja rapida e menos destrutiva
para realcar as qualidades da nossa modelo

Habilidades:

Técnica de colorizacdo usando camadas e efeitos de modos de mesclagem.
Tratamento de foto: Técnica de iluminacgao.

Dica especial de iluminacédo nao destrutiva.

Make profissional no photoshop.

Passo a passo:

Passo 01 Tirando as espinhas: Use a ferramenta Pincel de recuperacdo no
photoshop no modo automatico para remover machinhas, espinhas ou
gualquer outro detalhe ruim na foto.

Passo 02 Luz e Sombras-Use a ferramenta Dodge(Subexposicdo) e
Burn(Superexposicdo) para realcar as sombras e luzes, com a exposicdo a
15% lembrando que dodge é luz, e Burn é escuridao.

Passo 03 Cor na restauracdao- Use o pincel com opacidade entre 15px a 20px
para corrigir a iluminacdo nas areas de saturacdo. Selecione a cor da area de
luz e pinte delicadamente sobre ela e vice versa com areas escuras. porque
como é cor ndo vai saturar ainda mais a aquelas areas que ja estao saturadas

Passo 04 Colorizagdo - Ainda com o brush crie uma nova
camada(Shift+ctrl+n) e com ajuda de uma referencia pinte a sombra, se quiser



dar mais vida para a cor use modo de mesclagem “Sobrepor” (Overlay) e de
toques de cor no centro da sombra e use o modo multiplicar(multiplay) para
enfatizar as sombras, sempre de leve e se vocé sentir que exagerou diminua a
opacidade da camada para obter um efeito suave.

As camadas no Photoshop permitem que qualquer pessoa possa editar uma
foto construindo a imagem em diversas se¢0es de camadas.

Para vocé entender melhor, observe a figura abaixo, onde uma camada
principal foi duplicada trés vezes, gerando automaticamente trés novas
camadas em separado.

Este processo ajuda o profissional trabalhar individualmente em cada camada.

7

Um bom exemplo desta independéncia de cada camada é o interesse do
usuario em adicionar um brilho externo.

Para realizar esta acdo vocé deve seguir estes passos:
Passo 1: Selecionar uma das trés camadas duplicadas.

Passo 2: Clicar duas vezes nesta camada selecionada para abrir a caixa de
didlogo de Estilo de Camada.

Passo 3:Escolher a opcao Brilho Externoe dentro da area
chamado Estrutura escolher uma cor de preenchimento.

Realizado este processo clique no botdo OK.

DICA: Nunca se esqueca de nomear suas camadas. Tomando esta iniciativa,
vocé se mantém organizado e o ajudarad quando estiver trabalhando em um
grande projeto com muitas camadas.

Ferramenta Mover

Esta é uma das ferramentas que vocé vai usar com maior frequéncia no
Photoshop.

Com ela vocé pode executar varias funcées, como mover o conteudo de uma
camada, mover diretamente camadas de um documento para outro, copiar
camadas, aplicar transformacdes, selecionar e alinhar diversas camadas.

Em resumo € uma ferramenta de movimento, transformacéo e alinhamento.

DICA: A tecla de atalho desta ferramenta é “V".



Painel de Cores

Em se tratando de Photoshop € natural que todo usuério tenha o interesse de
usar, modificar, copiar e salvas cores personalizadas em seus projetos.

Por padréo na area de trabalho Essencial o painel cores fica localizado no lado
direito da sua tela na parte superior.

Outro local para encontrar as opgdes de cores e muito usada por boa parte dos
usuarios que ja estdo habituados no Photoshop é na parte inferior da barra de
ferramentas a esquerda, indicadas por duas caixas sobrepostas.

Ferramenta Corte Demarcado

E comum fazer algum tipo de corte para chamar mais a atencdo para o tema
de uma foto.

Esta ferramenta em especial tem evoluido consideravelmente desde a verséo
CS5. Em sua versao atual (CC 2017) ela dispbe de opcdes que ajudam
bastante o usuéario a criar o corte ideal para seus projetos.

Objeto Inteligente

Descoberto por fotégrafos, comecou sutiimente a receber melhorias ao longo
dos ultimos anos, se tornando uma das mais poderosas ferramentas do
Photoshop.

Um dos seus principais pontos positivos esta na capacidade de permitir ao
usuario trabalhar de forma ndo destrutiva em suas imagens, assim como nos
filtros que também sdo aplicados nestas imagens.

A Adobe diz que objeto inteligente € uma camada especial que pode conter
com tamanha intensidade informacfes de imagens ou vetores, preservando
sempre o conteudo original e todas as suas caracteristicas.

Em outras palavras, o objeto inteligente permite que o usuario possa realizar
edicbes ndo destrutivas no contetdo original. Com este recurso aplicado, vocé
pode criar praticamente qualquer ideia dentro do Photoshop.

1. Rotacione a visualizacéo

Em muitos casos, ver a imagem em um outro angulo pode ajudar. E possivel
fazer isso sem rotacionar o conteudo em si, mas sim sua tela. Pressione R no
teclado para ativar o recurso.
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2. Edite camadas de texto simultaneamente

Vocé nédo precisa editar uma camada de texto de cada vez no Photoshop.
Selecione todas e use a barra lateral de camadas no lado direito para editar
todas ao mesmo tempo.

3. Sele¢des mais precisas

Usando o botdo espaco do teclado, quando selecionar algum contetdo com a
ferramenta de sele¢do, vocé podera mové-la pela tela. Isso facilita para néo ter
gue remover a selecao e fazer de novo, em caso de um erro.

4. Veja uma camada sozinha

Para ver s6 uma camada e desativar todas as outras, basta pressionar Alt e
clicar no “olhinho” do lado da camada que vocé deseja ver.

5. Mova selecdes entre abas

Se quer mover a selecdo de alguma imagem de uma aba para outra do
programa, pode arrastar o mouse de uma para outra. Um processo bem mais
simples do que criar uma camada, copiar e colar.

6. Cole no local exato

Ainda sobre “interacdo” de imagens, se quiser manter algo copiado de uma
imagem para a outra, pressione Shift quando for fazer o Ctrl + C e Ctrl + V.
Assim, o conteldo sera colado no destino exatamente na posicdo que estava
de onde saiu.

7. Salve arquivos mais rapido

Desativar a compressao de imagens pode fazer com que vocé ganhe tempo.
Véa em Preferences, File Handling, e marque Disable Compression of PSD and
PSB files.

8. Caneta Magnética
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O laco magnético facilita a selecdo de conteldo em casos, por exemplo, de
recorte de imagens. Para usar a caneta magnética: selecione sua ferramenta
comum de Freeform Pen Tool e depois em Magnetic para ativar.

9. Corrigir Imagem Rapidamente

Use a Régua, trace uma linha horizontal e outro ponto de referéncia. Selecione
Image, Image Rotation e Arbitrary, e o Photoshop identifica certinho qual é o
posicionamento correto da imagem de acordo com as coordenadas.

10. Remova Granulado

As vezes, vocé fica com um granulado em imagens quando cola as mesmas
em outras camadas. Va na opc¢do Matting e depois acesse o menu Layer para
acessar uma seérie de recursos que pode ajudar a remové-lo.

11. Remova Reflexos

Uma nova ferramenta chamada Dehaze foi adicionada ao menu de efeitos. Va
em Filter, Camera Raw Filter, abra o menu Effects e selecione-a para ajudar a
remover reflexos em fotos de paisagens, por exemplo.

12. Borre

Borrar imagens nem sempre € ruim, e pode fazé-lo sem perder qualidade ou
realismo. Va ao menu Filter, selecione Blur e veja todas as op¢des de borrar
gue estao la. Alguma delas pode Ihe ajudar.

13. Lorem Ipsum

Se vocé quer usar o Photoshop para fazer layouts e ndo quer perder tempo
escrevendo qualquer coisa para simular texto, selecione a caixa de texto, va
em “Type” e em Paste Lorem Ipsum para preencher a caixa com um texto
padrao.

14. Exporte camadas
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Clique com o botdo direito em cima de uma camada no menu de Layers,
selecione Preferences e Export para definir o formato preferido e fazer sua
exportacao de uma determinada camada da sua imagem.

15. Qualquer imagem como Brush

Os brushes sédo uma maneira facil de trabalhar no Photoshop para dar efeitos
legais a fotos. E vocé pode transformar qualquer imagem facilmente em brush.
Selecione a camada, va em Edit e depois Define Brush Preset.

16. Preview de Fontes

O Photoshop permite que vocé va testando as fontes em uma camada de texto.
E s0 seleciona-la, selecionar o texto e ir na barra de fontes. L4, use as setinhas
para cima/baixo no teclado e as letras vdo mudando no texto.

17. Mais Desfazer

O recurso Desfazer do Photoshop é importante em trabalhos longos. Porém, o
limite de “lembrar” o histérico pode ser pequeno. Se vocé quiser aumentar, é s6
ir em Edit, Preferences, Performance e definir em History States.

18. Brushes Precisos

Edit, Preferences, Cursors. Este caminho permite que vocé defina o formato do
cursor para usar em diversas situacdes. Pode ajudar, por exemplo, a tornar o
uso de brushes mais preciso.

19. Autocorrecoes

Ha trés opcdes de autocorrecbes no menu Image: Tone (Tom), Contrast
(Contraste) e Color (Cor). Se vocé ndao entende muito de mexer nestas
propriedades, use para ver se sua imagem fica melhor.

20. Barras de Ferramentas



Sua experiéncia no Photoshop pode ser personalizada com as barras de
ferramentas que vocé achar ideal. Va em “Window” e selecione o que desejar
gue apareg¢a na sua navegacao; isso ajuda bastante.

Tratamento de Fotografia

Esta € uma técnica de tratamento de fotografia muito famosa e bonita que

geralmente é utilizada em Portraits — fotografias onde o foco principal é a
expressao facial.

Existem diversas maneiras de fazer este efeito, cabendo, portanto, ao gosto e
tempo do designer para fazer detalhes.

O interessante deste tutorial ndo é decorar os caminhos e sim compreender a
funcdo das ferramentas, pois desta maneira vocé, designer, podera fazer seus
proprios efeitos.

1° Passo: Ao abrir a imagem é necessario aumentar o contraste entre luzes e
sombras. Existem diversas formas de fazer isto. Vocé pode ir em Levels &
Cuvers ou Selective Color.
Usaremos a segunda opcao. Cligue em Image>Adjustments>Selective Color.

Em seguida clique na guia Colors e escolha a opcao Blacks como mostrado na
figura abaixo:
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2° Passo: Nessa janela coloque Black em +100% e mais uma vez va na guia
Colors novamente, mas desta vez selecione a op¢do Whites e altere o valor de
Black para +60%

3° Passo: Va em Levels (ctrl+L) e coloque os valores 39 — 0,90 — 255, como
indica a figura ao lado.

Nessa ferramenta aumentamos o contraste da imagem, mas diferentemente da
ferramenta anterior (Selective Color), onde vocé aumentou o contraste de duas
cores especificas (Preto e Branco), dando maior definicdo de sombras e luzes.

4° Passo: V4 em Select>Color Range para que apareca a janela da figura
acima.

Esta ferramenta merece um pouco de atencao, pois ela € fundamental neste
trabalho e possui uma funcdo muito interessante. Com ela € possivel
selecionar partes da imagem contém tonalidades de cores semelhantes.
Para iniciar a selecdo marque a opcao Image e em seguida margque a caixa
Invert para facilitar a visualizagdo da selecdo (a area escura da primeira
imagem representa a parte a ser selecionada).

Agora basta clicar na cor que deseja selecionar. Neste caso, eu cliquei na
sombra do lado esquerdo do nariz do modelo para selecionar as sombras do
rosto dele. Na barra Fuzziness coloque 130, esta barra representa a tolerancia
de selecdo da cor escolhida, quanto maior a tolerancia, maior sera a area de
selecdo.

Feito essas acoes, cligue em OK para obter uma selecdo bem parecida com a
segunda imagem.

5° Passo: Agora € preciso preencher 0 espaco selecionado.
Crie um novo layer indo em Layer>New> Layer (ctrl+shift+n) para colocar as
sombras que marcam o rosto.

Em seguida cligue em Edit>Fill (shift+F5) para que apareca a primeira imagem.
Na guia Contests, selecione a opcdo Color, preencha com a cor #190e03,
clique OK.

Em blending Mode coloque Darker e aperte em OK novamente.



Preenchemos a selecdo com um marrom escuro, valorizando ainda mais as
sombras e linhas de expressao.
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6° Passo: Agora iremos dar uma tonalidade diferente a imagem. Va em
Image>Adjustments>Variations.

Aparecerad uma tela com diversas de tonalidades para a fotografia, clique em
More Yellow, em seguida em Darker e posteriormente cligue em OK.
O resultado sera uma imagem com tom amarelo escuro.

7° Passo: Selecione a ferramenta Burn Tool (O) e configure-a da seguinte
forma: Range — Midtones, Exposure: 10%. Como a figura abaixo mostra.
Com esta ferramenta iremos acenturar as sombras da fotografia. Ap6s 0 uso

satisfatorio da Burn Tool selecione a Sharpen Tool (R) € e configure-a com o
Strenght: 30%. Com esta é possivel aumentar o contraste de partes especificas
da imagem. Neste caso, a usaremos nas areas com luminosidade,
sobrancelhas e linhas de expressao.
A figura dois mostra as areas onde a Sharpen Tool deve ser aplicada.
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8° Passo: E preciso baixar o nivel de saturacdo das cores, para isto va em
Image>Adjustments>Hue/Saturation, coloque a barra Saturation em -35% e
cliqgue em OK.

O resultado sera parecido com a imagem abaixo.

9° Passo: Agora faltam apenas alguns retoques finais. Pegue a foto original,
sobreponha a trabalhada. Coloque-a em 40% de Opacidade e Blending Mode:

Overlay.

Para dar maior expressividade a fotografia, vocé pode criar um novo Layer
(Layer>New>Layer) e fazer algumas luzes nos olhos com o Brush Tool em
60% opacidade.
Algumas pessoas tém a curiosidade de sabercomo fica a palheta de Layers ao
término do trabalho, a figura dois mostra a organizacao dos Layers no final do
trabalho.

Primeiro Abra uma fotografia qualquer que deseje aplicar os ajustes para fazer
o melhoramento dela com o Photoshop. Se vocé ja estiver com seu programa
aberto pode ir na barra de menu do programa selecionar a op¢ao arquivo >
Abrir.

Ajustes de Brilho e Contraste

Este é um dos ajustes mais simples de se fazer no programa e se aplica em
gualquer versao do editor. Com sua imagem aberta no editor va em Imagem >
ajuste > brilho e contraste.
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E so ir deslizando os dois controles para esquerda ou para direita até chegar
um efeito legal para sua foto.

Ajustes de Niveis

Os niveis sdo bastante utilizados no Photoshop para equilibrada os tons claros
e escuros de uma fotografia. Para fazer esse ajuste € bem simples va
em Imagem > Ajustes > Niveis.

Curvas

Esta opcdo é bem mais complexa do que as outras. Usuarios profissionais
optam por ela por fazer ajustes mais precisos e originais de iluminacéo. Ela
possui uma linha, vocé precisa criar pontos sobre essa linha, que pode ser feito
com cligues sobre ela, depois va arrastando a linha para cima e para baixo.

Existe diversas outras opcdes interessante de ajuste de cor e luz no editor que
vocé podem conferir na mesma categoria das opgdes mostradas acima.

Fotos tremidas e desfocadas

Essa outra dica que vou mostrar aqui € um recurso exclusivo da nova versao
do Photoshop. Trata-se de um filtro que faz o melhoramento de fotos que
sairdo tremidas e desfocadas. Para corrigir isso abra sua foto no Photoshop e
va em Filtro > Tornar Nitido > Reducéo de vibracao.

Ao fazer isso o editor ja ira aplica o filtro, e mostras as configuracdes que vocé
pode aumenta ou diminur para obter um resultado ainda melhor.

Criando um efeito de dupla exposi¢cao no Photoshop

Noés iremos chamar essas duas imagens de elemento frontal (0 homem de
negaocios) e imagem de fundo (os prédios de Nova York).

Primeiramente, abra o elemento frontal no Photoshop. A primeira coisa que

faremos é retirar o fundo. Por isso € melhor escolher uma imagem com um
fundo facil de ser removido, como 0 Nosso caso.

Se necessario, vocé podera utilizar a opcéo Refinar Aresta (atalho Alt + Ctrl +
R) para um corte mais preciso. Depois de selecionado, basta excluir o fundo,
como na imagem abaixo:

Agora chegou a hora de inserir a imagem de fundo (no nosso caso, o0s prédios).
Arraste a imagem para dentro do seu workspace no Photoshop. Ela abrird em



uma nova camada. Ajuste a opacidade dessa nova camada para 50% e
posicione a imagem da forma que achar melhor.

Depois disso, vamos criar uma mascara para essa hova camada que abriu.
Preste atencdo aos dois passos necessarios para isso:

Com o Ctrl pressionado, clique sobre a miniatura (seta n°1 na imagem abaixo)
da camada do elemento frontal (no nosso caso, 0 homem de negdécios). Isso
criard uma selecdo com a silhueta do homem.

Com a selecéo criada, selecione a camada da imagem de fundo (os prédios, no
nosso caso) e depois clique em Adicionar Mascara de Vetor (seta n°2 na
imagem abaixo).

Agora vocé ira retornar a opacidade da primeira camada para 100% inverter a
ordem das camadas.

A imagem de fundo (os prédios) ja esta com a mascara atras da imagem frontal
(o homem de negocios). Agora iremos utilizar a borracha na imagem principal
para que os predios aparecam,

Utilize a ferramenta borracha com diferentes niveis de opacidade. O segredo é
ir apagando a imagem frontal aos poucos, experimentando a borracha em
diferentes opacidades.

Experimente deixar partes da roupa visiveis, para dar um efeito ainda mais
interessante. No nosso caso, apos aplicar a borracha sobre a primeira camada
com opacidades variadas

Como a imagem do prédio € em preto e branco, vamos deixar a imagem frontal
em preto e branco também. Para isso, basta selecionar a primeira camada e
clicar em Imagens >> Ajustes >> Preto-e-Branco.

Nossa fotografia de dupla exposicéo ja esta ganhando forma, mas podemos ir
além disso. Podemos alterar a mascara para criar um efeito interessante nas
extremidades.

Para isso, cligue na camada do fundo e cliqgue na miniatura da mascara.
Lembre sempre do seguinte no que diz respeito a mascara: o que € branco
aparece. O que € preto, esconde.

Nds vamos recuperar uma pequena parte dos prédios na extremidade da foto.
Para isso, selecione o pincel na cor branca e pinte um pouco acima da cabeca
do homem. N&o se esqueca de clicar na miniatura da mascara antes de fazer
iSsO.

Agora, vamos utilizar os préprios prédios para criar um recorte interessante.



Depois de criar a selegcdo, basta mudar a cor do pincel para preto e pintar
dentro da selecdo. Dessa forma, esconderemos novamente parte do fundo,
criando um efeito bem legal

E para finalizar, basta repetir os passos da borracha e da mascara onde achar
necessario. Depois, adicione um fundo com a cor que desejar, e faca pequenos
ajustes de brilho, sombras e o que mais julgar interessante.

E claro que existem varias outras maneiras de se chegar a um resultado
semelhante. Mas essa é uma forma simples e rapida de criar um efeito de
dupla exposicao.

Passo 1. Abra o Photoshop no computador, selecione “Arquivo” e depois
“Abrir”. Encontre a foto que deseja e confirme em “Abrir”;

Passo 2. Crie uma nova camada da imagem. Para isso, acesse a lateral na aba
“Camadas”, clique com o botdo direito no icone da foto e selecione “Duplicar
Camada”. Confirme a agdo em “Ok”. Depois, desmarque o “Plano de Fundo” da
visdo, no icone de “olho”, para ver as mudangas. Deixe a camada do topo
selecionada.

Camada a partir do fundo...

Duplicar Camada...

Exciuir Camada

Exportagdo répida como PNG
Exportar como...

Converter em objeto inteligente

Mesclar Camadas
Mesclar camadas visivel

Achatar imagem

Nova camada 30 do arquivo...

Cartdo-postal

Passo 1. No lado esquerdo ha uma barra de ferramentas do Photoshop. Veja
trés formas de recortar e remover o fundo da sua foto. A primeira é a “Varinha
Magica”. O recurso permite selecionar superficies semelhantes de tom na foto.
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Clique no fundo e depois aperte o botdo de “Shift” no teclado para clicar em
areas semelhante do fundo.

Passo 2. Crie uma area do fundo totalmente selecionada e depois aperte o
botdo de “Delete” no teclado. Pronto.

Recorte pela Selecao Rapida

Passo 1. A ferramenta de “Selecdo Rapida” também € pratica para fotos com
fundo de cores e caracteristicas semelhantes. Basta clicar no fundo para criar a
selecdo completa

Passo 2. Faca a marcacgdo de todas as areas do fundo e, se necesséario, aperte
o botdo de “Shift” para somar areas e “Alt” para reduzir areas, caso tenha
passado de algum limite que ndo queira cortar.

Passo 3. Finalize com o botdo de “Delete”. Note que cada area ficara em
guadriculado, ou seja, sem fundo.

Ferramenta de Caneta (Pen Tool)

Passo 1. Por dltimo, e mais preciso, esta o recurso de Pen Tool. Com ela o
usuario cria pontos de eixos para gerar a selecdo. Em alguns casos € possivel
circular todo o objeto ou remover uma parte do fundo que néo deseja;

Passo 2. Faca a marcacdo de cada ponto, com cuidado, ao entorno da
imagem. Para as curvas, mantenha o cursor pressionado e gire 0 eixo da
marcacdo. Repita o processo até fechar a area completa, encontrando o
primeiro ponto com o ultimo;

Passo 3. Clique com o botdo direito na area selecionada e escolha “Criar
Selecdo”. Em seguida, com a area tracejada, apague o fundo no botdo de
“Delete” no teclado. Ele ficara quadriculado, como nos demais passos.

Salvando as imagens

Passo 1. Clique em “Arquivo” e depois em “Salvar como”. Caso queira salvar a
foto sem o fundo, ou em transparente para edi¢cdes futuras, é ideal usar o
formato “PNG”. Caso prefira com o fundo branco escolha o formato “JPEG”.

Confirme em “Salvar”.
Melhorias na ferramenta Select & Mask (Ferramenta de Selecdo e Mascaras)

Todo o algoritmo da ferramenta de selecdo e mascaras foi refeito, para
trabalhar com selecdes de imagens bem complexas. De acordo com a Adobe,
a ideia é que a ferramenta seja capaz de entregar resultados mais realistas e



precisos, principalmente em casos de recorte em que as cores do objeto e do
fundo sejam muito parecidas.

Para usufruir dessa funcionalidade melhorada, primeiro vocé utiliza a Quick
Selection Tool e depois usa a Refine Edge Tool. Em poucos minutos testando
essa nova funcionalidade eu percebi que sim, melhorou incrivelmente,
principalmente no recorte de objetos complexos como arvores e cabelos. Com
certeza vai melhorar em muito o trabalho de quem lida com edi¢cé&o de imagens.

Suavizagéao de tracados

O Photoshop agora é capaz de criar uma suavizacéao inteligente nos tracados
de pincel (Brush Strokes). Para ver como essa nova funcionalidade atua, basta
escolher um valor (0 a 100) na barra de opg¢des para “Smoothing” (Suavizagao)
em qualquer uma das ferramentas: Brush (Pincel), Pencil (Lapis), Mixer
Brush (Pincel de Mistura) ou Eraser(Borracha). Se vocé colocar o valor 0, vera
uma suavizacao igual a das versdes antigas do Photoshop, e quanto maior o
valor, mais suaves 0s tragos.

No modo Pulled String, vocé o cursor “puxando” o trago, como se houvesse
uma corda. No modo Stroke Catch Up, o traco segue o cursor até vocé parar
de tracar, e no modo Catch-Up On Stroke End, o traco se completa no ponto
em que vocé soltou o mouse ou caneta. SGo modos bem interessantes de
desenho, principalmente para artistas digitais e ilustradores que trabalham com
tablets e mesas desenhadoras, pois cria tracos muito naturais.

Outra novidades dessas ferramentas é a possibilidade de simetria das pinturas,
gue pode ser ativada espelhando os desenhos para criar padrées e estampas
complexos. Para ativar, va em Preferéncias > Visualizacdes de tecnologia >
Ativar simetria de pintura.

3. Melhorias no Plugin Camera Raw

O Camera Raw Editor é um plugin que permite importar e aprimorar imagens
no formato raw, e sO esta disponivel para usuarios do Creative Cloud. A
novidade é que vocé pode criar mascaras de selecdo para ajustar 0s controles
de Luminescéncia (Luminance) e Cor (Color). Isso permite modificar cores,
tons e luzes de determinados elementos de uma imagem, uma funcionalidade
muito interessante que permite um trabalho bem realista.

4. Fontes Variaveis

Essa nova funcionalidade € um negécio incrivel que eu tenho certeza de que
deixara muitos designers empolgados como eu fiquei. A Adobe néo inventou as
fontes variaveis, mas inserindo o suporte a esse formato de fontes OpenType,
vai facilitar a vida de muita gente. A ideia é que vocé consiga alterar nas fontes
suportadas (identificadas com um icone com as letras VAR no painel) varios



atributos como espessura, largura, inclinacdo, entre outros. Ou seja, vocé tera
centenas de opc¢bes de fontes em uma s6, usando controles deslizantes no
painel de propriedades.

5. Nova Caneta de Curvatura (Curvature Pen Tool)

Essa nova ferramenta presente no grupo de ferramentas de curvatura deve
ajudar a vida de muita gente que trabalha com formas e contornos. Vocé pode
criar segmentos de curva com linhas retas e curvas suaves, com bastante
facilidade. Além disso também € possivel editar os pontos, remover e adicionar
pontos de uma forma sem precisar trocar de ferramenta.

Eu testei um pouco essa ferramenta e ela facilita bastante o traco e contorno
de linhas, facilitando a criagcdo de formas e linhas bem simétricas e suaves.

O Photoshop CC 2018 veio cheio de novidades incriveis, eu listei apenas as 5
gue mais me agradaram pessoalmente. Entretanto, a lista de atualizacdes €
grande e bem animadora. Agora, por exemplo, é possivel copiar e colar layers
usando o comando copiar e colar, importando todos os atributos do layer. Alias,
essa funcédo ficou especialmente melhor quando se quer copiar de um
documento para outro. Ao redimensionar imagens, o0s detalhes sé&o
preservados gracas ao aumento assistido por um algoritmo de Inteligéncia
Artificial.

Outra coisa bacana implementada € a melhoria da biblioteca de pincéis. Agora,
vocé pode trabalhar com presets de pincéis organizando-0os em grupos, e se
vocé importar presets de pincéis, eles entram na biblioteca como pincéis
mesmo. Algo bem interessante principalmente para oS mais novatos no
software é o “Learn Panel”’, em portugués, o painel Saiba Mais. Esse painel
apresenta varios tutoriais sobre ferramentas e conceitos dentro do Photoshop,
gue sao guias passo-a-passo bem explicativos.

O Adobe Photoshop CS3 é um poderoso programa de edi¢cdo de imagens que
pode ser usado para criar ou preparar imagens para impressao e uso ha
internet, bem como para restaurar ou adicionar vida a imagens. Este programa
€ usado por profissionais e entusiastas e €& compativel tanto para
computadores com Windows, quanto Macs.

Compre o Adobe Photoshop CS3. Este programa esta disponivel em CD, ou
para download.

Instale o Adobe Photoshop CS3.



Passe algum tempo analisando os recursos disponiveis para os usuarios do
Adobe Photoshop CS3. Estes recursos incluem tutoriais, videos, foruns e feeds
RSS.

Abra o Adobe Photoshop CS3.
Comece a se familiarizar com a area de trabalho do Photoshop.

A barra de menu esta localizada no topo da area de trabalho e organiza os
comandos por categoria.

O painel de ferramentas (também chamado de paleta de ferramentas) esta
localizado do lado esquerdo do programa e contém ferramentas para adicionar
texto e criar e editar artes, imagens e outros elementos gréficos.

Muitas ferramentas tém diversas opcdes. O painel de controle (também
chamado de barra de opc¢bes) exibe as opcdes (se disponiveis) da ferramenta
com a qual vocé esta trabalhando.

A janela do documento € a parte principal da tela onde seu arquivo atual esta
sendo exibido.

Os painéis (também chamados de paletas) sdo maneiras de monitorar as
mudancas que vocé fez em seu trabalho e de fazer modificacbes. O painel de
camadas (Layers) (também chamado de paleta de camadas, ou Layers Palette)
€ um painel usado com frequéncia. Vocé pode adicionar, ou remover paineis
selecionando o painel que vocé quer adicionar a partir do menu Janela
(Window), localizado na barra de menu. Vocé pode organizar ainda mais sua
area de trabalho empilhando e fixando seus painéis.

Abra a imagem que vocé deseja editar, ou crie uma nova imagem.

Quando estiver criando uma nova imagem, especifique o tamanho, a resolucéo
e o plano de fundo dela.

Escolha "Tamanho da Imagem" ("Image Size") a partir do menu Imagem
(Image) se vocé estiver trabalhando com uma imagem existente. O menu de
imagem esta localizado na barra de menu.

Desmarque "Redefinir imagem" ("Resample Image"). Redefinir muda a
guantidade de dados em uma imagem e pode afetar sua qualidade
negativamente.

Redimensione sua imagem ajustando a largura, ou altura em pixels, ou
centimetros. Para ajustar o tamanho da imagem proporcionalmente, escolha
"Manter proporc¢ao” ("Constrain Proportions").

Ajuste a resolucédo da imagem, se vocé achar necessario.



Ajuste 0 modo de cor da sua imagem se necessario selecionando "Modo"
("Mode") a partir do menu de imagem, na barra de menu.

Modifique a cor dentro da sua imagem ajustando as camadas, curvas, matiz ou
saturacdo, ou usando uma combinacdo dessas opc¢Oes. Elas podem ser
acessadas no submenu "Ajustes” ("Adjustments") do menu imagem.

Retoque sua imagem conforme necesséario selecionando a ferramenta
adequada a partir do painel de ferramentas.

Salve a imagem usando um novo nome de arquivo selecionando "Salvar como"
("Save as") a partir do menu Arquivo (File). Evite modificar imagens originais.

O Adobe Photoshop CS3 oferece varias opcdes de formato de arquivo. Para
impresséo, o formato .tif € o melhor, enquanto as imagens .jpg sdo as melhores
para uso na web.

O Adobe Photoshop CS3 contém diversas funcionalidades para retoque e
transformacédo de imagens, incluindo ferramentas para adicionar, ou remover
itens, focar, ou desfocar imagens, adicionar texto e corrigir falhas.

Os modos de cores podem ser RGB (red, green, blue) ou CMYK (cyan,
magenta, yellow, black). Eles determinam como as cores sdo exibidas em
imagens impressas, ou eletrénicas.

Resolucdo € o numero de pixels por polegada em uma imagem. Quanto maior
a resolucédo, maior a qualidade da imagem impressa. Se vocé estiver usando a
imagem em um site, ou outro formato digital, uma resolucdo menor é aceitavel.
Uma resolucdo de 72 dpi geralmente € adequada para imagens da internet,
enquanto 300 dpi é preferivel para imagens impressas.

Ferramentas

—
l-’/‘Pincel — usando na maior parte do tempo para pintar, mesclar cores, etc.
Vocé pode mudar os ajustes de acordo com suas necessidades (forma,
opacidade, presséo, etc).

G

I€2.Burn Tool (Ferramenta Superexposicdo) — sera usada em trés diferentes
modos de mesclagem, para escurecer partes da pintura.

}‘\ADodge Tool (Subexposicédo) — sera usada em trés diferentes mesclagens,
para clarear partes da pintura.

Pd <Eyedropper Tool (Ferramenta Conta-Gotas) — usada para pegar amostras
de cor da pintura.



e

', Gradient Tool (Ferramenta Degradé) — usada para o inicio, onde sera feita
a colorizacéo do fundo.

Outras Ferramentas usadas com frequéncia:
Liquify Tool — localizada no menu Filter > Liquify (Filtro > Dissolver)

Ajustes de Levels, Curves, Hue ou Saturation (Niveis, Curvas,
Matiz ou Saturacdo) —localizado no menu Image > Adjustments (Imagem >
Ajustes)

Mude o ajuste do pincel. Os ajustes mais usados estdo marcados em
vermelho. Isso vai permitir que vocé crie qualquer pincel de acordo com suas
necessidades. Quando precisar de um pincel de ponta fina ou redonda mais
dispersa, esses ajustes permitirdo que vocé crie o pincel perfeito para sua
necessidade.

Vocé pode usar isso de referéncia para criar manualmente as cerdas de um
pincel e criar texturas especificas, se quiser; 0 processo € basicamente o
mesmo. Para salvar o pincel, clique no pequeno icone proximo ao cesto no
canto inferior direito no menu de formas (shapes).

Se ndo tem uma mesa digitalizadora, pode usar o controle Fade
control (controle de dispersdo) em vez da Pen pressure (Pressdo da caneta).
N&do esqueca de salvar sua imagem com frequéncia para evitar perda das
configuracoes.

Sombreamento

Crie uma nova camada. Escolha uma cor clara (deve se encaixar a
luminosidade da cena! Se quiser uma cena iluminada por luz fria, escolha um
tom de azul claro, roxo ou verde, ou se quiser uma coloracao guente, use cores
como amarelo e laranja. A iluminacdo DEVE ser condizente!) e comece a
adicionar luzes livremente (usei um pincel
personalizado, Opacity Jitter ajustado para Pen Pressure, 0%).

Vocé pode fazer o mesmo com as sombras quando achar que as luzes estédo
ok (as sombras devem ter cor oposta das luzes e também um tom mais escuro
do que sera a pele, normalmente isso funciona muito bem).



A pele deve ter muitas cores. Nao tenha medo de usar cores complementares
gue normalmente vocé ndo vé na pele de alguém, o resultado serd muito mais
natural depois que for suavizado.

Usei areas luminosas em azul claro, entdo as sombras devem ter laranja (na
verdade, marrom-alaranjado, j& que laranja seria muito claro aqui). Também
adicionei algumas luzes amarelas nas areas claras, para dar mais vida a pele e
adicionar algum contraste.

Escolha um pincel redondo, grande, borda dura (hard edge, rounded); pode
variar entre 95 a 100% de dureza (hardness). S6 tome cuidado para ndo usar
pincéis aerografo, isso tornaria a pele um tanto artificial. Se preferir, use o
mesmo pincel personalizado de antes, com Opacity Jitter ajustado para Pen
pressure 0%.

Comece a pintar adicionando cores e suavizando. Use a Eyedropper
Tool (Conta-gotas) para escolher cores de sua paleta (se tiver uma) e
também das suas pinceladas (segurando a tecla Alt enquanto usa o pincel,
vocé usa temporariamente o Eyedropper).

Dicas de suavizagao

Adicione cores com seu pincel, entdo use o Eyedropper em cada pincelada, a
cada duas ou trés pinceladas, pintando de novo com opacidade mais
baixa; pressione cada vez menos a caneta na tablet, até que fique uma
mesclagem bem suave.

Olhos

Agora veremos como obter um efeito brilhante nos olhos e como adicionar
profundidade e realismo a eles.

Use a Dodge Tool (Ferramenta Subexposicdo, atalho: O), para adicionar
luminosidade. Use a ferramenta com pincel redondo e suave, pequeno 0O
suficientes para os pequenos detalhes.

Escolhi o modo highlights, pois isto mantém a cor saturada o bastante, mas
vocé pode tentar outros modos. Vocé pode também usar a Burn
Tool (Ferramenta Superexposicdo) para escurecer regifes e criar efeito de
profundidade. N&do use o modo highlight, ou os olhos vao parecer sujos. Use o
modo midtones ou shadow.

Se néo estiver satisfeito com 0 esquema de cores, vocé pode ir ao menu Image
> Adjust > Levels (ou Curves, ou Hue/Saturation, etc), e fazer experiéncias com
as configuracdes, até chegar ao que vocé espera.



Para adicionar as pétalas caindo

Crie uma nova camada, e selecione uma cor rosa clara (vocé pode usar um
tom das sombras da pele, um pouco mais saturada). Use um pincel de borda
suave, redondo (round, soft edge), ou o pincel personalizado usado antes, para
pinta-las.

Quando tiver adicionado pétalas o suficiente, vocé pode dar algum movimento
a elas: va ao menu Filter > Blur > Motion Blur (Filtro > Desfoque > Desfoque de
movimento), e mudar os ajustes até ficar satisfeito.

Esta técnica vai ajudar a adicionar pétalas pequenas no fundo. As pétalas da
frente devem ser pintadas separadamente, ndo se esquecendo de fazer
algumas mais nitidas, para obter efeito de profundidade e realismo (veja o
exemplo da imagem anterior). Vocé pode detalhar um pouco as mais proximas,
trabalhando em suas cores (pinte algum tipo de degradé nelas).

Cabelos

Cabelos sao importantes por contribuir em muito na personalidade do
personagem.

Use o pincel grande redondo, borda dura (ou o mesmo pincel personalizado de
antes), opacity jitter e size jitter em pen pressure, para desenhar as primeiras
mechas de cabelo. Use uma cor escura; detalhes claros serdo pintados sobre
as mechas escuras, mas depois. Quando estiver satisfeito com a forma geral
do cabelo, selecione um pincel pequeno, borda dura (opacity jitter e size
jitter em pen pressure, 0%), e pinte cabelos individuais usando cores claras,
especialmente nas partes que sao afetadas por fontes de luz. Nao se
esqueca de adicionar cabelos que nao fluem na mesma direcdo dos demais:
pequenas imperfeicdes sdo importantes tanto nos cabelos quanto na pele.

Pérolas

Para pintar as pérolas, escolha um cinza claro ndo-neutro (levemente colorido).
A cor ndo deve ser saturada, mas evite cinza neutro ou as pérolas parecerao
apagadas. Nunca use cinza neutro nas suas pinturas, isso criaria uma “falha”
na imagem.

Use um pincel redondo, borda dura, para pintar a forma basica das pérolas.
Escolha um cor mais escura e saturada e pinte uma sombra dentro da pérola,
usando um pincel redondo, borda suave (soft edge, round). Agora vocé pode
usar a Dodge tool (modo highlight) e adicionar a luminosidade final ao topo da
pérola. Se quiser, claro, também pode usar uma cor saturada para a base.



